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Legal Notices

Open Text Corporation

275 Frank Tompa Drive, Waterloo, Ontario, Canada, N2L OA1

Copyright Notice

Copyright 2022-2024 Open Text.

The only warranties for products and services of Open Text and its affiliates and licensors (“Open Text”) are as may be set forth
in the express warranty statements accompanying such products and services. Nothing herein should be construed as
constituting an additional warranty. Open Text shall not be liable for technical or editorial errors or omissions contained herein.
The information contained herein is subject to change without notice.

Trademark Notices

“OpenText” and other Open Text frademarks and service marks are the property of Open Text or its affiliates. All other
trademarks or service marks are the property of their respective owners.

Documentation Updates

The title page of this document contains the following identifying information:
o Software Version number
¢ Document Release Date, which changes each time the document is updated

e Software Release Date, which indicates the release date of this version of the software

This document was produced on September 11, 2024. To check for recent updates or to verify that you are using the most
recent edition of a document, go to:

https://www.microfocus.com/support/documentation
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Preface

Contacting Customer Support

Visit the Support website to:

¢ Manage licenses and entitlements

¢ Create and manage technical assistance requests
¢ Browse documentation and knowledge articles

¢ Download software

¢ Explore the Community

https://www.microfocus.com/support

For More Information

For more information about Fortify software products:

https://www.microfocus.com/cyberres/application-security

About the Documentation Set

The Fortify Software documentation set contains installation, user, and deployment guides for all
Fortify Software products and components. In addition, you will find technical notes and release notes
that describe new features, known issues, and last-minute updates. You can access the latest versions
of these documents from the following Product Documentation website:

https://www.microfocus.com/support/documentation

To be notified of documentation updates between releases, subscribe to Fortify Product
Announcements on the OpenText Fortify Community:

https://community.microfocus.com/cyberres/fortify/w/announcements

Fortify Product Feature Videos

You can find videos that highlight Fortify products and features on the Fortify Unplugged YouTube
channel:

https://www.youtube.com/c/FortifyUnplugged
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Change Log

The following table lists changes made to this document. Revisions to this document are published
between software releases only if the changes made affect product functionality.

Software Release /
Document Version Changes

24.1 [/ Revision 1. Updated:

September 2024
P ¢ Added supported IDE versions (see "Fortify Security Assistant

Requirements" on the next page)

¢ Improved description of auto-remediation ("Finding Security Issues as
you Write Code" on page 10)

24.1 Updated:

¢ Added information about how to apply plugin provided code fixes to
automatically remediate vulnerability issues (see "Finding Security
Issues as you Write Code" on page 10 and "Working with the Fortify
Security Assistant Window" on page 15)

¢ Added content for ability to use the IDE's storage for trusted certificates
(see "Configuring Fortify Security Assistant" on page 7)

23.1 Updated version and release date

22.2 Updated:

¢ Added a requirement for downloading security content from
OpenText™ Fortify Software Security Center ("Fortify Security Assistant
Requirements" on the next page)
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Getting Started

The Fortify Security Assistant Plugin for IntelliJ (Fortify Security Assistant) works with a portion of
the Fortify security content to provide alerts to potential security issues as you write your Java code.
Fortify Security Assistant provides quick-fix actions for some vulnerabilities, detailed information
about security risks, and recommendations for how to secure the potential issue.

Fortify Security Assistant includes both structural and configuration analyzers to detect:

¢ Potentially dangerous uses of functions and APIs

¢ Insecure application configurations in property and XML files

Fortify Security Assistant notifies you of any detected issues as you write your code. You can also
examine an entire project and then review the detected security issues.

Note: The instructions in this guide describe a third-party product and might not match the
specific, supported version you are using. See your product documentation for the instructions
for your version.

Fortify Security Assistant Requirements

Fortify Security Assistant requires:

¢ Avalid Fortify license file
For information about how to obtain a Fortify license, contact Customer Support.
e Supported IntelliJ IDEA versions: 2022.2, 2022.3,2023.x, 2024.1
¢ Supported Android Studio versions: 2022.2, 2023.x
¢ Up-to-date Fortify Secure Coding Rulepacks (Fortify security content)

Fortify Security Assistant uses a knowledge base of rules to enforce secure coding standards
applicable to the codebase for static analysis. The Fortify Secure Coding Rulepacks describe
general secure coding idioms for popular languages and public APIs.
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To update Fortify Software Security Content, do one of the following:
e Download the Fortify security content directly from the Fortify Rulepack update server or from a
Fortify Software Security Center server.

Important! To download security content from a server that is configured to use HTTPS,
you must first import a self- or locally-signed certificate into the Java Runtime Environment
(JRE) certificate store. See the IntelliJ IDEA or Android Studio documentation for more
information. The following are examples of the certificate storage location:

IntelliJ IDEA: <IDE_install_dir>/jbr/lib/security/cacerts

Android Studio: <IDE install_dir>/jre/lib/security/cacerts
You can also use the IDE's storage for frusted certificates (see "Configuring Fortify Security
Assistant" below).

e Load Fortify security content from your local system.
You might choose this option if you do not have a network connection fo a server.

For instructions on these options, see "Configuring Fortify Security Assistant" below.

Installing Fortify Security Assistant

You can install Fortify Security Assistant on Windows, Linux, and macOS. The Fortify Security
Assistant plugin is available for download from the JetBrains Marketplace.

To install Fortify Security Assistant:

Start IntelliJ IDEA or Android Studio.

Open Settings or Preferences.

In the left pane, select Plugins.

Select the Marketplace tab, and then in the search box type Fortify Security Assistant.
Select the Fortify Security Assistant Plugin for IntelliJ and then click Install.

6. Click OK.

If this is the first time you installed Fortify Security Assistant, you must next specify the Fortify license
file and load Fortify security content (see "Configuring Fortify Security Assistant" below).

u ks W e

Configuring Fortify Security Assistant

In order for Fortify Security Assistant to detect vulnerabilities in your code, you must have a valid
Fortify license file and up-to-date Fortify security content. You can download Fortify security content
from the Fortify Rulepack update server (https://update.fortify.com), or from a Fortify Software
Security Center server.

If you do not have a network connection to the Fortify Rulepack update server or a Fortify Software
Security Center server, Fortify Security Assistant can load Fortify security content from a local folder.
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To configure Fortify Security Assistant:

1. Open Settings or Preferences.

2. Inthe search box, type fortify.
3. Select Fortify Security Assistant in the left pane.

Other Settings » Fortify Security Assistant Reset

License

License file:

Security Content

Use local Rulepack
Folder:
o Use security content server

URL: https:/fupdate.fortify.com Default

Software Security Center
Security content date: Mot Updated

Use IDE certificate management system

Use proxy

Server:
Port:

User name:
Password:

4. To specify the license file, click Browse to the right of the License file box and navigate to the
license file (fortify.license) on your system.
5. To load or update Fortify security content stored locally:

a. Select Use local Rulepack.

b. Click Browse next to the Folder box and navigate to a folder on your system that contains
the Rulepacks.

The selected folder must contain Rulepacks as ZIP, XML, or BIN files.
c. Click Load Security Content.
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6. To download Fortify security content from a Rulepack update server or from Fortify Software
Security Center:

a. Select Use security content server.

b. To download security content from the Fortify Rulepack update server, in the URL box, type
a Rulepack server URL.

The default is the Fortify Rulepack update server URL (https://update.fortify.com).

Note: Click Default to set the URL to the default Fortify Rulepack update server.

¢. To download security content from Fortify Software Security Center:
i. Inthe URL box, type a Fortify Software Security Center URL.
ii. Select the Software Security Center check box.

d. To connect to the security content server through a proxy server, select Use proxy, and then
provide the following:

° The proxy server host name (for example, my.proxy.com)

© The proxy port number

© (Optional) Authentication credentials for the proxy server
e. Click Check for Updates.

Note: If you get an error that indicates the downloaded security content is unverified,
you might have an invalid license file. Contact Customer Support for assistance.

7. To use the IDE's storage for trusted certificates, select Use IDE certificate management
system.

8. Click OK.
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Finding Security Issues as you Write Code

As you review the code inspections in the code editor, Fortify Security Assistant provides a detailed
description of the Fortify-detected issues. Using a rules-based auto-remediation engine, the plugin
can also provide suggested fixes in the interactive preview. Critical issues are shown in red in the code
editor. Fortify Security Assistant also provides notifications of security issues in the Fortify Security
Assistant window and the IDE Problems ool window.

protected void configure(HttpSecurity httpSecurity) throws Exception {
httpSecurity.sessionManagement().sessionCreationPolicy(SessionCrea’

e httpSecurity.headers().frameOptions().disable():
} [Fortify] - Remove headers().frameOptions().disable() |
F = [Fortify] - View Vulnerability Details
Introduce local variable
no Usages
@Configuratio Press Ctri+Q to toggle preview

In the code editor, place the cursor over the line of code that is marked as an issue, and do one of the
following:

¢ Click to apply the suggested auto-remediation if available

¢ Click View Vulnerability Details

The Fortify Security Assistant Vulnerability Details window opens and provides a detailed
description of the issue, examples, and recommendations of how to fix the issue.

Detected issues displayed in the Problems window are prefixed with [Fortify - <priority>] as
shown in the following example:

Proeblems:  Current File Project Errors o —

® = beans.scml
© Element security:headers is not allowed here 10
Mamespace location is never used 7
[Fortify - High] Authenticating a user without invalidating any existing session identifier gives an attacker the opportunity

See Also
"Viewing Vulnerability Details" on the next page

"Scanning a Project for Security Issues" on page 12
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Viewing Vulnerability Details
To see a detailed description of an issue, from the code editor or the Fortify Security Assistant
window, right-click the issue, and then select View Vulnerability Details.

The Vulnerability Details window provides a detailed description of the issue, examples, and
recommendations of how to fix the issue.

Vulnerability Details A
Category &
(XXE) XML External Entity Injection -
Abstract

Using XML parsers configured to not prevent nor limit external entifies resolution can
expose the parser to an XML External Entifies attack.

Explanation

XML External Entities attacks benefit from an XML feature to build documents
dynamically at the time of processing. An XML enfity allows inclusion of data dyvnamically
from a given resource. External entities allow an XML document to include data from an
external URI. Unless configured to do otherwise, external enfities force the XML parser to
access the resource specified by the URI, ez, a file on the local machine or on a remote
system. This behavior exposes the application to XML External Enfity (XXE) attacks,
which can be used to perform denial of service of the local system, gain unauthorized
access to files on the local machine, scan remote machines, and perform demial of service
of remote systems. The following XML document shows an example of an XXE attack.

<?xmlL version="1.0" encoding="IS0-8859-1"?>
<!DOCTYPE foo [
<IELEMENT foo ANY =
<IENTITY xxe SYSTEM "file:///dev/random" >]><foo=&xxe:</foc

This example could crash the server (on a UNIX system), if the XML parser attempts to
substitute the entity with the contents of the /dev/random file.
XML parsers can be conficured to enable and disable certain features for performance and
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Suppressing Issues

You might want to suppress warnings for specific issues that might not be high priority or of
immediate concern.

To suppress issues, use the native IntelliJ IDEA or Android Studio suppress inspections feature in the
code editor. You can suppress issues from the code editor and the Problems window.

For more information about re-enabling suppressed inspections, see the documentation for your IDE.

The visibility of suppressed issues in the Fortify Security Assistant window depends on the setting
for the Suppressed column). For instructions on how to change the visibility of suppressed issues, see
"Working with the Fortify Security Assistant Window" on page 15.

See Also

"Disabling Vulnerability Categories" on the next page

Scanning a Project for Security Issues

You can analyze the whole project (or a specific set of files) and identify security issues. You cannot
make any code changes during the analysis.

To scan a project for issues:

¢ Run the IDE code inspection.

If you see the following message in the Event Log:
Please wait for the security content (Rulepack) to be loaded. Security
content is required to detect vulnerabilities.

Then wait until the Fortify security content is loaded. Run the code inspection again after you see the
following message:

Fortify Security Assistant is ready to work

Fortify Security Assistant displays any detected issues in the IntelliJ IDEA or Android Studio
Problems window. The issues are grouped by analyzer as shown in the following example.
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Problems File Project Errors Server-Side Analysis  Vulnerable Depen
~. 7 Inspection Results 670 errors
) General 33 errors

HTML

Internationalization 1 error
JVM languages
Java
gl » Markdown
') » Maven 5 errors
Proofreading
Properties files 587 errors
¥ » Security
Security Assistant - Properties
2, » Security Assistant - Structural 2 errors
Security Assistant - XML

The detected security issues are also displayed in the Fortify Security Assistant window. For
information about reviewing the security issues in the Fortify Security Assistant window, see
"Working with the Fortify Security Assistant Window" on page 15.

Disabling Vulnerability Categories

As you review Fortify detected issues, you might want to completely disable a category of reported
issues. It is useful to disable vulnerability categories if you are sure that the vulnerability category is
not, and will never be, an issue of concern.

All issues in the disabled vulnerability categories are not reported again unless you re-enable them
(see "Enabling Vulnerability Categories" on the next page).

To disable a vulnerability category, use the native IntelliJ IDEA or Android Studio disable inspection
feature (File > Settings > Editor > Inspections). There are three groupings of Fortify Security
Assistant vulnerability categories:

e Security Assistant - Properties

¢ Security Assistant - Structural

e Security Assistant - XML

Note: You can also disable a Fortify vulnerability category for a scanned project from the
Problems window.

After you clear a check box for a vulnerability category, issues that fall into that vulnerability category
are no longer highlighted in the code as a Fortify Security Assistant detected issue.
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Enabling Vulnerability Categories

To re-enable a Fortify vulnerability category that you have disabled, use the native IntelliJ IDEA or
Android Studio re-enable inspection feature (File > Settings > Editor > Inspections). Locate the
Fortify Security Assistant vulnerability category you want to re-enable and select the check box.

Note: You can also re-enable a vulnerability category for a scanned project from the Problems
window. To refresh the issues displayed in the Fortify Security Assistant window after re-enabling
a vulnerability category, rescan the project (see "Scanning a Project for Security Issues" on
page 12).

See Also

"Disabling Vulnerability Categories" on the previous page
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Working with the Fortify Security Assistant
Window

Fortify Security Assistant displays all the security issues detected as you write code and for open files
in the Fortify Security Assistant window.

Fortify Security Assistant

| Fortify Priority  Rule ID Description Category Suppressed  File Ling
) = JCADOASE... Content Security Policy (CSP)... HTMLS : Missing Content 5... Active fwebgoat-container/src/mainfjava/orglowas... 58
‘.‘“) = JCADSASE... Content Security Policy (CSP). HTMLS : Missing Content 5... Active fwebwolf/sre/mainfjavalorglowasplwebwol 50
550AB58A... Deserializing user-controlled Dynamic Code Evaluation : Active fwebgoat-container/pom.xml G4
& EEAQODTS... Standard pseudorandom num... Insecure Randomness Active fwebgoat-lessons/challenge/src/mainfjaval... 14
T EEAQQDYD... Standard pseudorandom num. Ingecure Randomness Active fwebgoat-lessons/crypto/sreimainjavalorg 53
bl EEAQODTS.,, Standard pseudorandom num... INSecure Randomness Active fwebgoat-lessons/cryptofsrc/mainfjavalorg... 55
) EEAQODT9... Standard pseudorandom num... Insecure Randomness Active /webgeat-lessons/crypto/sre/mainfjavalerg... 74
) EEAQODTE.,. Standard pseudorandom num.., insecure Randomness Active fwebgoat-lessons/csri/sre/mainijavalorgfo... 82

The following table describes the Fortify information provided for each issue.

Column Description
Fortify Colored icon indicates the Fortify Priority Order used to categorize the severity of
Priority a vulnerability
e (g Critical
. High
. Medium
. Low
Rule ID Unique identifier of the rule that triggered the vulnerability detection
Description Brief description of the issue
Category Fortify vulnerability category
Suppressed Indicates whether the issue has been suppressed

Note: By default, suppressed issues are not visible in this window. To see
suppressed issues in this list, select View Options, and then select Show
Suppressed.
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Column Description

File Name of the file where the issue occurs. To change whether to show the file path
or only the file name, select View Options, and then select Show Short File
Name.

Line Line number where the issue occurs in the file.

As you review the detected issues, you can do the following:

¢ Read more information about the vulnerability by right-clicking an issue, and then selecting View
Vulnerability Details.

Note: If the Vulnerability Details window is already open, click an issue to see the
corresponding details in this window.

¢ Open the file and locate the line of code where the issue was found by clicking the issue.

¢ Show only issues where Fortify Security Assistant has a fix by selecting View Options, and then
selecting Show only Issues with a Fix.

¢ Show issues for the current file only by selecting View Options, and then selecting Show only
Current File.

¢ Group the issues by file name, Fortify Priority, Fortify Rule ID, or Fortify category by clicking View
Options and then selecting the grouping you wantf.

¢ Change whether suppressed issues are visible by selecting View Options, and then selecting Show
Suppressed.

e Copy the rule ID for an issue by right-clicking the issue, and then selecting Copy Rule ID.

See Also
"Viewing Vulnerability Details" on page 11

"Suppressing Issues" on page 12

Troubleshooting

For help diagnosing a problem, you can open the Fortify Security Assistant log file from the IDE. To
open the log file, select Help > Show Fortify Security Assistant Log. If you contact Customer
Support, provide them with this log file.
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Send Documentation Feedback

If you have comments about this document, you can contact the documentation feam by email.

Note: If you are experiencing a technical issue with our product, do not email the documentation
team. Instead, contact Customer Support at https://www.microfocus.com/support so they can
assist you.

If an email client is configured on this computer, click the link above to contact the documentation
team and an email window opens with the following information in the subject line:

Feedback on User Guide (Fortify Security Assistant Plugin for IntelliJ and Android Studio 24.1)
Just add your feedback to the email and click send.

If no email client is available, copy the information above to a new message in a web mail client, and
send your feedback to fortifydocteam@opentext.com.

We appreciate your feedback!
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